# Table of Contents

**Introduction**.................................................................................. 4
**Requirements**................................................................................ 4
**Requirements**................................................................................ 4
**Features**.......................................................................................... 4
**Specification/Operating Conditions**.................................................. 4

**Installation**....................................................................................... 6
  Install the Java Runtime Environment (JRE)........................................ 6
  Install DecoderPro............................................................................... 7
  Connect the Power Supply..................................................................... 7
  Install SPROG II USB drivers................................................................. 7
  Edit DecoderPro Preferences................................................................ 15
  Connect the Programming Track............................................................ 18

**Getting Started With DecoderPro**....................................................... 19

**Using the DecoderPro Throttle**.......................................................... 28
  Speed Matching of Locos..................................................................... 30
  Measuring Loco Current...................................................................... 30

**Getting Started With PanelPro**............................................................ 31

**Layout Control with SPROG II**............................................................. 35
  SPROG Command Station Mode........................................................... 35
  Short (one byte) Versus Extended (two byte) Addressing.................... 39
  How Many Locos Can Be Controlled?................................................... 39

**Using an External Booster with SPROG II**........................................... 40

**Connecting and Using Multiple SPROG IIs**.......................................... 41

**Determining the SPROG II Firmware Version**........................................ 42

**Updating SPROG II With the Bootloader**............................................. 43

**Troubleshooting**............................................................................... 44

**Useful Links**..................................................................................... 45
**Introduction**

SPROG II is a DCC decoder programmer for connection to the serial port of a personal computer or similar device. SPROG II is supported by DecoderPro and PanelPro, both part of the JMRI project ([http://jmri.sourceforge.net/](http://jmri.sourceforge.net/)) which, by use of the java programming language, allows platform independent support of a wide range of DCC hardware. JMRI is shareware available as a free download.

SPROG II is also capable of operating a small layout using the features of DecoderPro and PanelPro. A larger layout can be driven by using an external booster.

**Requirements**

- Java programming language JRE from Sun Microsystems [http://java.sun.com](http://java.sun.com)
- Regulated DC Power Supply (see Table 1)
- Short length or small oval of track for programming and/or test running

**Features**

- Programs virtually *all* NMRA compliant DCC decoders
- No extra hardware required for programming sound decoders (e.g. QSI, Soundtraxx)
- Easy to use graphical interface with DecoderPro
- USB interface for easy connection to PC
- USB activity LED shows communication with the PC
- Power LED flashes when programming track power is live
### Specification/Operating Conditions

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Minimum</th>
<th>Nominal</th>
<th>Maximum</th>
<th>Units</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC Input supply voltage</td>
<td>10V</td>
<td></td>
<td>15V</td>
<td>V</td>
<td>1</td>
</tr>
<tr>
<td>Vin supply current – not programming</td>
<td>50</td>
<td></td>
<td></td>
<td>mA</td>
<td></td>
</tr>
<tr>
<td>Vin supply current – programming</td>
<td>300</td>
<td></td>
<td></td>
<td>mA</td>
<td>2</td>
</tr>
<tr>
<td>Vin supply current – Operating Layout</td>
<td>1</td>
<td></td>
<td></td>
<td>A</td>
<td>3</td>
</tr>
<tr>
<td>Operating Temperature Range</td>
<td>25</td>
<td></td>
<td></td>
<td>°C</td>
<td></td>
</tr>
<tr>
<td>Output Load - programming</td>
<td></td>
<td>250</td>
<td></td>
<td>mA</td>
<td>2</td>
</tr>
<tr>
<td>Output Load – Operating Layout</td>
<td></td>
<td></td>
<td>1</td>
<td>A</td>
<td>3</td>
</tr>
</tbody>
</table>

Notes:

1. Minimum supply voltage depends upon the requirements of the decoder being programmed. In general it is safer to use as low a voltage as possible in case of problems with a newly installed decoder.
2. SPROG II will remove track power if output current exceeds 250mA as measured 100ms after applying power. Surge current during decoder power-up may be considerably greater than this.
3. Depends upon required DCC current.
4. SPROG II is protected against reverse polarity connection of the power supply but will not work unless the polarity is correct.

**SPROG II is not protected against track and power connections being interchanged.**

*Table 1 Specification/Operating Conditions*
Installation

The following steps are required to install SPROG II before you can use it for the first time:

- Install the Java Runtime Environment (JRE)
- Install DecoderPro
- Connect the Power Supply
- Install SPROG II USB drivers
- Edit DecoderPro preferences
- Connect the Programming Track

For a successful installation, the JRE must be installed before DecoderPro is installed.

This document gives brief installation instructions for the Windows Operating System. For full instructions and for instructions to install the JRE and DecoderPro on Linux or MACOS, please refer to the Install Guides on the JMRI website at http://jmri.sourceforge.net/download

Look out for the animated SPROG II “Show Me How!” guides on the SPROG II website in the near future.

Install the Java Runtime Environment (JRE)

The Java Runtime Environment is not required for MACOS, which has Java support as standard. For Windows and Linux it must be installed first, either from the CD-ROM supplied or from a downloaded copy.

To install from the CD-ROM, use “My Computer” or “Windows Explorer” to browse to the directory specific to your operating system.
Double click the j2re executable file and follow the on-screen instructions to install.

**Install DecoderPro**

DecoderPro should then be installed from the CD-ROM or a downloaded copy. A newer version of DecoderPro than that supplied on the CD-ROM may be available from the JMRI download page [http://jmri.sourceforge.net/download](http://jmri.sourceforge.net/download)

DecoderPro versions with an even sub-version number, e.g., 1.8, are stable “production” releases that have been well tested and should have no major issues. Odd sub-version numbers, e.g., 1.9.1, 1.9.2 are test releases that are generally stable but may exhibit issues, especially with new features that may still be under development.

To install from the CD-ROM, browse to the directory specific to your operating system (as per the previous step). Double click on the JMRI.1.x.exe file and follow the on-screen instructions to install.

**Connect the Power Supply**

Observe the correct polarity (marked as 0V and +V) when connecting the power supply to the pluggable terminal block. SPROG II is protected against reverse polarity connection of the power supply but will not work unless the polarity is correct.

The power LED will illuminate steadily when the SPROG II is powered up and...
the USB connected to the host computer (next step).  
The power LED will flash when the programming track is powered up.

**Install SPROG II USB drivers**

Use the supplied USB cable to connect SPROG II to the host computer. The power LED should be lit. The first time you do this you will see the “Found new Hardware Wizard”. Follow the steps below to install the SPROG II drivers and then the USB Serial port drivers.

**USB Drivers**

Click “No, not this time” then “Next >”.

![Found New Hardware Wizard](image)
Click “Install from a list or specific location” then “Next >”. 

Click “Search for the best driver in these locations” then “Include this location...”
in the search" and then click the Browse button to find the driver directory on the CD-ROM supplied with SPROG II. Click “Next >”.

Click “Continue Anyway”.

Please wait while the wizard installs the software...

Setting a system restore point and backing up old files in case your system needs to be restored in the future.
Click "Finish"

**USB Serial Port Drivers**

Click "No, not this time" then "Next >"
Click “Install from a list or specific location” then “Next >”
Click “Search for the best driver in these locations” then “Include this location in the search” and then Browse to find the driver directory on the CD-ROM supplied with SPROG II. Click “Next >”

Click “Continue Anyway”
Click "Finish"

**Edit DecoderPro Preferences**

The next step is to the DecoderPro preferences in order to allow the software to connect to the SPROG II.

First you must ascertain which COM port was assigned to SPROG II during the driver installation. Open the System Properties from the Windows Control Panel (you may need to switch to classic view. Alternatively, right click on the Desktop My Computer Icon and select Properties.

Select the Hardware tab:
Click “Device Manager”

Click the “+” to open the Ports (COM & LPT) category and note the COM port assignment for the SPROG II (COM4 in this example).
Now start DecoderPro by double clicking the icon that was placed on the Windows desktop during the installation.

Open the Edit -> Preferences dialog from the menu

Click the arrow in the Layout connections field and scroll down to select SPROG
Click the arrow in the Serial Port field and select the COM port noted in the earlier step.

Select the desired GUI style.

Select the Comprehensive Programmer Format

Click “Save”

Click “Yes”. DecoderPro will save the new settings and exit.

Connect the Programming Track

The programming track MUST be isolated from all other DC or DCC control systems and connected only to the SPROG II. Damage may result to the SPROG II or other equipment if this rule is not followed.
Connect the SPROG II to the programming track using the “Track” terminals of the pluggable terminal block. There is no requirement to observe any particular polarity when connecting the programming track. The DCC output voltage will be approximately 1V below the power supply voltage.

During programming the track current is sensed 100ms after the programming track is powered up. If the current exceeds 250mA then the programming track power is removed to avoid potential damage to an incorrectly installed decoder.
Getting Started With DecoderPro

See the DecoderPro website http://jmri.sourceforge.net for updates and latest information.

Join the JMRI Yahoo group http://groups.yahoo.com/group/jmriusers for help from other DecoderPro users and the team who develop it.

Ensure that all software and drivers are installed and that DecoderPro preferences have been setup.

Start DecoderPro. The main window will open and show the current connection method as set by the preferences. In the following example “Connected via SPROG on COM4”:

Click “Service Mode (Programming Track) Programmer” to open the Programmer Setup window. The new window shows a list of decoder manufacturers.
Clicking the control or double clicking the folder icon next to a manufacturer name will open a list of decoder types from that manufacturer. You can always manually select a decoder type in this way. In most cases, DecoderPro can determine the manufacturer and decoder type automatically.

Place a decoder equipped loco on the programming track and click on “Read type from decoder”. In the example below, DecoderPro has identified a QSI Industries BLI F7. Sometimes DecoderPro can identify the manufacturer but not exact model of decoder fitted. In these cases it will be necessary to select the decoder type manually.
Once the decoder type has been selected, click “Open Programmer”. The service mode programmer window opens with a selection of “tabs”, grouped in rows below the menu bar, Clicking on a tab selects a group of CVs to be programmed, related to the title of the tab. The selection of tabs available will vary depending upon the features supported by your decoder and the CVs available.

On the “Roster Entry” tab you may enter arbitrary details of the loco to be saved on the PC for future reference. The DCC address field will be filled in by DecoderPro once the decoder has been read or programmed. If you wish to use the Roster then you should make sure to click “Save” on the Roster.
Entry tab when you have finished programming the decoder. The Roster is especially useful if the decoder loses its settings as seems to happen occasionally with some decoders. Alternatively, you may wish to program a second loco with similar CV settings.
Click on the “Basic” tab and you will see the most basic settings for the decoder including the address. Initially, all of the data fields are coloured red or yellow to show that no data has been read from or written to the decoder. There are eight read and write buttons at the bottom of the window. Click “Read full sheet” to read the data for the current tab from the decoder.

Clicking “Read all sheets” will read every CV from the decoder and may take a considerable time to complete.

Each data field should return to white or the background colour of the window.
To change to locos address, type a new address in the Active DCC Address followed by carriage return. The address field will turn orange, indicating that the address has been changed but not yet written to the decoder. Select the type of address to be set (short or extended).

Click “Write changes on sheet” to write the new address to the decoder. The address will turn red and then white as it is written to the decoder. You can set other basic properties such as the direction and DC operation on this tab.

The other tabs work in a very similar way. You may find it useful to have the decoder documentation available when setting more complex or manufacturer specific features.

Next we’ll look at the Speed Control tab that allows you to fine tune the way the loco responds to the throttle. Click on the “Speed Control” tab.
The decoder in this example has a choice between “Use Straight-Line response” and “Use QSI table or User table in CVs 67 through 94”. The “look and feel” of this tab will vary between decoders but most recent decoders support the use of a speed table.

It is left as an exercise for the reader to experiment with the sliders for setting the speed table and the buttons just below. The “Force Straight” option will give a linear relationship between the throttle position and the speed of the loco. “Constant ratio curve” will give little change in speed at low throttle settings, greater change at higher throttle.

Remember to write the changes on each sheet before moving to a new one. Next, click on the “Function Map” tab.
The Function Map allows you (in those decoders that support it) to control which throttle function key is mapped to each output wire or operation (e.g. sound effect) of the decoder.
DecoderPro comes into its own for programming the many and varied options in a sound decoder. Here is an example Sound tab from the BLI F7 where the volume of individual effects may be set.

Again, remember to write your changes.

Hovering over an item with the cursor will often show a short description for that item, but it is highly recommended that you read the documentation for your decoder to get the best from it with DecoderPro.
Using the DecoderPro Throttle

Using a DecoderPro throttle, it is possible to test run a loco after programming CVs, e.g., to test the effect of changing the speed table of function mapping. Using a rolling road or a continuous loop of track for programming is recommended for test running.

Using PanelPro and the throttle, it is possible to control a small “one engine in steam” layout, including control of accessories (e.g. point motors) with SPROG II. More than one loco may be present on the layout but only one may be selected on the throttle and driven at one time.

Care should be taken when using the service mode programmer that only one loco is on the layout during programming, or that the layout is isolated except for a short section of track for programming. If a programming operation is performed whilst the whole layout is connected, then incorrect data will be read from CVs and all locos on the layout will be re-programmed.

On the main DecoderPro window, click on the “Tools” menu item and then select “Throttles” and “New Throttle…”

![DecoderPro Throttles](image)

SPROG II, when used as a programmer, supports the use of one DecoderPro throttle. See “Layout Control with SPROG II” for details of how to use SPROG
Il as a command station with multiple throttles.

When the throttle window opens, enter the loco address and click “Set”.

With SPROG II, loco address less than 128 are assumed to be short (2 digit) addresses. Addresses greater than 127 are assumed to be extended (4 digit) addresses.

Setting the loco address will enable the function buttons and speed slider.

The LED icon in the centre of the menu bar is the track power control and must be clicked until it is green to turn on the track power. The SPROG II power LED will flash when the track power is live.

**Note:** After programming using the service mode programmer, the track power is always left in the off state and must be turned on again from the throttle power control before the loco can be run.

The function keys have a latching operation. Click once to turn a function on, click again to turn the function off.
To control the loco speed, click and drag the slider caret (the pointy bit!). For fine control of speed, click on the slider just above or below the caret. The “STOP!” button will stop the loco but does not turn off the track power. To set a different loco address, click the “Dispatch” or “Release” button. These two buttons have the same effect with SPROG II.

**Speed Matching of Locos**

*To come in a future release of this document…*

**Measuring Loco Current**

Loco current may be measured by using SPROG II in command station mode and using the slot monitor, see “Layout Control with SPROG II”.
Getting Started With PanelPro

The PanelPro tool included with JMRI allows SPROG II to be used for the control of DCC accessory decoders for point (turnout) control.

The limited output voltage and current capability of SPROG II means that it is not suitable for use with accessory decoders that take power from DCC. Accessory decoders should be chosen that take commands from DCC but use a separate power input for the point motors.

This is only a very brief introduction, see the PanelPro homepage at http://jmri.sourceforge.net/apps/PanelPro/PanelPro.html for more details.

On the main DecoderPro window, click on the “Panels” menu item and then select “New Panel…”
A blank Panel and the Panel Editor window will open.

You can set the panel name to be used when saving the panel. Use the File menu in the panel editor to save the panel.

You can draw a background track plan in a graphical editing tool and then load the image as the background for the panel. It may take some experimenting to get the track spacing correct to match the panel icons.
To add a turnout, click in the box next to the “Add right/left-hand turnout” button. Enter the accessory address of the turnout and click the appropriate “Add” button. A turnout icon will be added to the panel. The icon may be repositioned by clicking and holding the right mouse button and dragging the icon to its new position. In the example below, a right-hand turnout has been added and moved. The pop-up menu shows the accessory address prefixed with “ST” for “SPROG Turnout”. The turnout may be rotated, disabled or removed using the same menu.

Clicking the “Add icon” button will add a straight track section.

In the next step, two straight line segments and a left hand turnout (address 2) have been added and aligned to represent the layout of a passing loop.
Left clicking on a turnout icon will change the icon and send the appropriate DCC accessory command to change the turnout on the layout. Here, both turnouts have been clicked to select the route into and out of the passing loop.

The track power must be on for any accessory commands generated from the panel to be effective.
Layout Control with SPROG II

SPROG Command Station Mode

A new feature in DecoderPro versions from 1.9.2 onward is the ability to use SPROG II as a command station with control of multiple locos through on screen throttles.

When operating in this mode, SPROG II is no longer a service mode (programming track) programmer. CVs may still be written in operations mode (also known as “on the main” programming) but the contents of CVs cannot be read back.

To use SPROG II as a command station, you must first modify the DecoderPro preferences in a similar manner as was done during initial installation of the SPROG II.

Open the Edit -> Preferences dialog from the menu
Click the arrow in the Layout connections field and scroll down to select “SPROG Command Station”.

Click “Save”

Click “Yes”. DecoderPro will save the new settings and exit.

Start DecoderPro again. You may now open multiple throttles, one for each loco you wish to control. See below for a note on the limit to the number of locos that can be controlled.

Use the power control in any of the throttles to turn the track power on or off.

An additional feature in Command Station mode is the slot monitor which is accessed from the SPROG menu in the main DecoderPro window.
The top portion of the slot monitor contains a checkbox to control whether unused slots are displayed, a button to force an emergency stop of all locos and the output current being supplied by the SPROG II.

The output current reading will not reflect the layout current if an external booster is being used.

The output current readings are filtered and averaged over a number of readings by SPROG II and the display in the slot monitor will change more slowly than the actual output current.

The remainder of the slot monitor is the list of slots, at least one slot is associated with each throttle (see below).
In this example, SPROG II is supplying 163mA to the layout. A loco with address 997 is running in reverse at speed step 35 and a loco with address 1 is running forwards at speed step 43.

When you use a function button on a throttle, you will see an extra slot occupied momentarily with the address of the loco on that throttle and speed 0. This indicates that the function command is being sent to the loco. To allow for errors in reception, function commands are repeated three times. After the third copy is sent, the slot will be cleared.
Short (one byte) Versus Extended (two byte) Addressing

The DCC specification allows two forms of loco address:

- Short addresses in the range 1 – 127
- Extended addresses in the range 1 – 10239

Most DCC systems impose their own arbitrary limits on these address ranges. In SPROG Command Station mode the allowable address ranges are:

- Short addresses TBD…
- Long addresses TBD…

How Many Locos Can Be Controlled?

Sixteen slots are available, but SPROG II is not capable of operating sixteen locos without an external booster.

Run each loco individually with a representative load and note the current reading. The total required for your layout will depend upon the “diversity” or how many, and which, locos are to be operated at the same time.

It should be possible to run at least 3 or 4 modern HO, 00 or N lightly loaded locos.

Some slots should always be left free for sending function control commands. These free will be shared between throttles as required, it is not necessary to have a free slot for every throttle.
Using an External Booster with SPROG II

Yes, it is possible.

To come in a future release of this document…
Connecting and Using Multiple SPROG IIs

At the present time it is not possible to use the alternate connection method in DecoderPro to connect a second SPROG II.

It is, however, possible to run two (or more) separate instances of DecoderPro connected to two (or more) SPROG IIs, e.g.

- One SPROG II in command station mode running the layout
- One SPROG II in normal or command station mode running PanelPro to control accessories
- One SPROG II in normal mode connected to a programming track

If used this way, the programming track should be wired via a DPDT switch so that it can be connected to the main layout (to allow locos to be driven on to it) or connected to the SPROG II programmer, not both at the same time.

Never connect more than one SPROG II or a SPROG II and any other booster or DC controller to the same section of track.
Determining the SPROG II Firmware Version

To Come in a future release of this document…
Updating SPROG II With the Bootloader

To Come in a future release of this document…
**Troubleshooting**

Before reporting any problems please check the SPROG II homepage for any bug reports or updates. There is a SPROG II FAQ page which will be updated to reflect the most common questions people have about SPROG.

If you have problems with programming a decoder, or operating DecoderPro throttles, for instance, please turn on the SPROG command monitor

*How to do it (in pictures) will be in a future release of this document…*

(found under the SPROG menu in DecoderPro), recreate the problem and send the output of the command monitor to sprog@sprog-dcc.co.uk with a description of the problem.
Useful Links

SPROG homepage http://www.sprog-dcc.co.uk for the latest information, updates, downloads, etc., for SPROG II.

SPROG DCC Yahoo group http://groups.yahoo.com/group/sprog-dcc for latest news and discussion of DecoderPro.


JMRI Yahoo group http://groups.yahoo.com/group/jmriusers for latest news and discussion of DecoderPro.

Sun Microsystems http://java.sun.com to download the Java programming language JRE required by DecoderPro.